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1.  INTRODUCTION

The RCM3360 and RCM3370 RabbitCore modules feature a

compact module that incorporates the latest revision of the power-

ful Rabbit® 3000 microprocessor, flash memory, mass storage

(NAND flash), static RAM, and digital I/O ports. The RCM3360

and RCM3370 feature an integrated 10/100Base-T Ethernet port,

and provide for LAN and Internet-enabled systems to be built as

easily as serial-communication systems.

In addition to the features already mentioned above, the RCM3360 and RCM3370 have 

two clocks (main oscillator and real-time clock), reset circuitry, and the circuitry necessary 

for management of battery backup of the Rabbit 3000’s internal real-time clock and the 

static RAM. Two 34-pin headers bring out the Rabbit 3000 I/O bus lines, parallel ports, 

and serial ports.

The RCM3360’s and the RCM3370’s mass-storage capabilities make them suited to running 

the optional Dynamic C FAT file system module where data are stored and handled using 

the same directory file structure commonly used on PCs.

The RCM3360 or RCM3370 receives +3.3 V power from the customer-supplied mother-

board on which it is mounted. The RCM3360 and RCM3370 can interface with all kinds 

of CMOS-compatible digital devices through the motherboard.

The Development Kit has what you need to design your own microprocessor-based 

system: a complete Dynamic C software development system and a Prototyping Board 

that allows you to evaluate the RCM3360 or RCM3370, and to prototype circuits that 

interface to the RCM3360 or RCM3370 module.
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1.1  RCM3360 and RCM3370 Features

• Small size: 1.85" x 2.73" x 0.86"

(47 mm x 69 mm x 22 mm) 

• Microprocessor: Rabbit 3000 running at 44.2 MHz

• 52 parallel 5 V tolerant I/O lines: 44 configurable for I/O, 4 fixed inputs, 4 fixed outputs

• Three additional digital inputs, two additional digital outputs

• External reset

• Alternate I/O bus can be configured for 8 data lines and 6 address lines (shared with 

parallel I/O lines), plus I/O read/write

• Ten 8-bit timers (six cascadable) and one 10-bit timer with two match registers 

• 512K flash memory, 512K program execution SRAM, 512K data SRAM

• Fixed and removable mass-storage flash-memory options, which are required to run the 

optional Dynamic C FAT file system module.

• Real-time clock

• Watchdog supervisor

• Provision for customer-supplied backup battery via connections on header J4

• 10-bit free-running PWM counter and four pulse-width registers

• Two-channel Input Capture (shared with parallel I/O ports) can be used to time input 

signals from various port pins

• Two-channel Quadrature Decoder accepts inputs from external incremental encoder 

modules

• Five or six 3.3 V CMOS-compatible serial ports with a maximum asynchronous baud 

rate of 5.525 Mbps. Three ports are configurable as a clocked serial port (SPI), and two 

ports are configurable as SDLC/HDLC serial ports (shared with parallel I/O ports).

• Supports 1.15 Mbps IrDA transceiver

The RCM3300/RCM3310 and RCM3305/RCM3315 RabbitCore modules are similar to 

the RCM3360/RCM3370 and RCM3365/RCM3375, but they use fixed serial flash for 

their mass-storage flash memories instead of the fixed or removable NAND flash options 

of the RCM3360/RCM3370 and RCM3365/RCM3375.
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Table 1 below summarizes the main features of the RCM3360 and the RCM3370 modules.

Two new RabbitCore modules, the RCM3365 and the RCM3375, are now available. They 

are similar to the RCM3360 and the RCM3370, but they feature a “hot-swap” capability 

for the removable xD-Picture Card. The two groups of RabbitCore modules are compared 

in detail in Section 1.2. The RabbitCore RCM3365/RCM3375 User’s Manual provides 

complete information on the RCM3365 and RCM3375 RabbitCore modules.

The RCM3360 and RCM3370 are programmed over a standard PC serial port through a 

programming cable supplied with the Development Kit, and can also be programed through 

a USB port with an RS-232/USB converter, or directly over an Ethernet link using the 

Dynamic C download manager with or without a RabbitLink.

Appendix A provides detailed specifications for the RCM3360 and the RCM3370.

Table 1.  RCM3360/RCM3370 Features

Feature RCM3360 RCM3370

Microprocessor Rabbit 3000 running at 44.2 MHz

SRAM 512K program (fast SRAM) + 512K data

Flash Memory 

(program)
512K

Flash Memory

(mass data 

storage)

16 Mbytes (fixed) + up to 128 

Mbytes (removable)

(NAND flash)

up to 128 Mbytes 

(removable)

(NAND flash)

Serial Ports

6 shared high-speed, 3.3 V CMOS-compatible ports:

• all 6 are configurable as asynchronous serial ports;

• 4 are configurable as a clocked serial port (SPI) and 1 is 

configurable as an HDLC serial port;

• option for second HDLC serial port at the expense of 2 

clocked serial ports (SPI)
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1.2  Comparing the RCM3365/RCM3375 and RCM3360/RCM3370

The RCM3365/RCM3375 provides enhanced functtionality over the RCM3360/RCM3370 

RabbitCore modules in that the removable xD-Picture Card can be hot-swapped. The 

design differences between the RCM3365/RCM3375 and the RCM3360/RCM3370 

RabbitCore modules are summarized below.

• xD-Picture Card hot-swapping. The control and data signals from the xD-Picture 

Card are isolated on the RCM3365/RCM3375, and bit PB0 is used to detect the pres-

ence of the xD-Picture Card. If this card detect capability is not needed, resistor R96 

may be removed to maintain pin compatibility with the RCM3360/RCM3370.

• SPEED LED. A SPEED LED has been added on the RCM3365/RCM3375 to indicate 

when the RCM3365/RCM3375 is connected to a 100Base-T Ethernet connection.

• Ethernet chip. A different Ethernet controller chip is used on the RCM3365/RCM3375. 

You will need to recompile existing applications written for the RCM3360/RCM3370 

using the current version of Dynamic C to enable them to work with the RCM3365/

RCM3375.

• Maximum current. The RCM3365/RCM3375 draws 250 mA vs. the 350 mA required 

by the RCM3360/RCM3370.

1.3  Advantages of the RCM3360 and RCM3370

• Fast time to market using a fully engineered, “ready-to-run/ready-to-program” micro-

processor core.

• Competitive pricing when compared with the alternative of purchasing and assembling 

individual components.

• Easy C-language program development and debugging

• Program download utility (Rabbit Field Utility) and cloning board options for rapid 

production loading of programs.

• Generous memory size allows large programs with tens of thousands of lines of code, 

and substantial data storage.

• Integrated Ethernet port for network connectivity, with royalty-free TCP/IP software.

• Ideal for network-enabling security and access systems, home automation, HVAC 

systems, and industrial controls
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1.4  Development and Evaluation Tools

1.4.1  RCM3360/RCM3370 Development Kit

The RCM3360/RCM3370 Development Kit contains the hardware you need to use your 

RCM3360 or RCM3370 module.

• RCM3360 module.

• Prototyping Board.

• AC adapter, 12 V DC, 1 A (included only with Development Kits sold for the North Amer-

ican market). A header plug leading to bare leads is provided to allow overseas users to 

connect their own power supply with a DC output of 8–30 V.)

• Programming cable with 10-pin header and DE9 connections.

• Dynamic C® and Dynamic C FAT file system module CD-ROMs, with complete product 

documentation on disk.

• Getting Started instructions.

• 32 MB xD-Picture Card™.

• Accessory parts for use on the Prototyping Board.

• Screwdriver and Ethernet cables.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.

Figure 1.  RCM3360/RCM3370 Development Kit
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RabbitCore RCM3360/RCM3370
Getting Started

Development Kit Contents

The RCM3360/RCM3370 Development Kit contains the following items:

• RCM3360 module.

• RCM3300 Prototyping Board.

• AC adapter, 12 V DC, 1 A. (Included only with Development Kits sold for the North American market. A 

header plug leading to bare leads is provided to allow overseas users to connect their own power supply 

with a DC output of 8–30 V.)

• 10-pin header to DB9 programming cable with integrated level-matching circuitry.

• Dynamic C CD-ROM, with complete product documentation on disk.

• Ethernet cables and screwdriver.

• Getting Started instructions.

• 32 MB xD-Picture Card™ (NAND flash)

• A bag of accessory parts for use on the Prototyping 

Board.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.

Installing Dynamic C

Insert the CD from the Development Kit in 

your PC’s CD-ROM drive. If the installation 

does not auto-start, run the setup.exe

program in the root directory of the 

Dynamic C CD. Install any Dynamic C 

modules after you install Dynamic C.
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1.4.2  Software

The RCM3360 and the RCM3370 are programmed using version 9.01 or later of Dynamic C. 

A compatible version is included on the Development Kit CD-ROM.

Z-World also offers for purchase add-on Dynamic C modules including the popular µC/OS-II 

real-time operating system, as well as point-to-point protocol (PPP), Advanced Encryp-

tion Standard (AES), FAT file system, Secure Sockets Layer (SSL), RabbitWeb, and other 

select libraries. In addition to the Web-based technical support included at no extra charge, 

a one-year telephone-based technical support module is also available for purchase. Visit 

our Web site at www.zworld.com for further information and complete documentation for 

each module, or contact your Z-World sales representative or authorized distributor.

NOTE: Version 2.05 or later of the Dynamic C FAT file system module is required to use 

the FAT file system with the RCM3360 and RCM3370 models.

1.4.3  Connectivity Interface Kits

Z-World has available additional interface kits to allow you to provide a wireless interface 

to the RCM3360/RCM3370 and to use the RCM3360/RCM3370 with header sockets that 

have a 0.1" pitch.

• Wi-Fi Add-On Kit (Z-World Part No. 101-0997)—The Wi-Fi Add-On Kit for the 

RCM3000–RCM3300 footprint consists of an RCM3000–RCM3300 Interposer Board, 

a Wi-Fi CompactFlash card with a CompactFlash Wi-Fi Board, a ribbon interconnect-

ing cable, and the software drivers and sample programs to help you enable your 

RCM3360/RCM3370 module with Wi-Fi capabilities. The RCM3000–RCM3300 

Interposer Board is placed between the RCM3360/RCM3370 module and the 

RCM3300 Prototyping Board so that the CompactFlash Wi-Fi Board, which holds the 

Wi-Fi CompactFlash card, can be connected to the RCM3360/RCM3370-based system 

via the ribbon cable provided.

• Connector Adapter Board (Z-World Part No. 151-0114)—allows you to plug the 

RCM3360/RCM3370 whose headers have a 2 mm pitch into header sockets with a 0.1" 

pitch.

Visit our Web site at www.zworld.com or contact your Z-World sales representative or 

authorized distributor for further information.

1.4.4  Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, use your browser to find and load default.htm in the docs 

folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our Web sites as well.
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2.  GETTING STARTED

This chapter explains how to set up and use the RCM3360/

RCM3370 modules with the accompanying Prototyping Board.

NOTE: It is assumed that you have a Development Kit. If you purchased an RCM3360 or 

RCM3370 module by itself, you will have to adapt the information in this chapter and 

elsewhere to your test and development setup.

2.1  Install Dynamic C

To develop and debug programs for the RCM3360/RCM3370 (and for all other Z-World 

and Rabbit Semiconductor hardware), you must install and use Dynamic C.

If you have not yet installed Dynamic C version 9.01 (or a later version), do so now by 

inserting the Dynamic C CD from the Development Kit in your PC’s CD-ROM drive. If 

autorun is enabled, the CD installation will begin automatically.

If autorun is disabled or the installation otherwise does not start, use the Windows 

Start | Run menu or Windows Disk Explorer to launch setup.exe from the root folder 

of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the 

process are self-explanatory.

Dynamic C uses a COM (serial) port to communicate with the target development system. 

The installation allows you to choose the COM port that will be used. The default selec-

tion is COM1. You may select any available port for Dynamic C’s use. If you are not cer-

tain which port is available, select COM1. This selection can be changed later within 

Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Speci-

fying a port in use by another device (mouse, modem, etc.) may lead to a message such 

as "could not open serial port" when Dynamic C is started.

Once your installation is complete, you will have up to three icons on your PC desktop. 

One icon is for Dynamic C, one opens the documentation menu, and the third is for the 

Rabbit Field Utility, a tool used to download precompiled software to a target system.

Install any Dynamic C modules after you have installed Dynamic C. The modules may be 

installed in any order. You must install the modules in the same directory where 

Dynamic C was installed.
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2.2  Hardware Connections

There are three steps to connecting the Prototyping Board for use with Dynamic C and the 

sample programs:

1. Attach the RCM3360/RCM3370 module to the Prototyping Board.

2. Connect the programming cable between the RCM3360/RCM3370 and the workstation 

PC.

3. Connect the power supply to the Prototyping Board.

2.2.1  Attach Module to Prototyping Board

Turn the RCM3360/RCM3370 module so that the Ethernet jack is facing the direction 

shown in Figure 2 below. Align the pins from headers J3 and J4 on the bottom side of the 

module into header sockets JA and JB on the Prototyping Board. The picture card (NAND 

flash) does not have to be inserted into header J6 on the RCM3360/RCM3370 at this time.

Figure 2.  Install the RCM3360/RCM3370 Module on the Prototyping Board

NOTE: It is important that you line up the pins on headers J3 and J4 of the RCM3360/

RCM3370 module exactly with the corresponding pins of header sockets JA and JB on 

the Prototyping Board. The header pins may become bent or damaged if the pin align-

ment is offset, and the module will not work. Permanent electrical damage to the mod-

ule may also result if a misaligned module is powered up.

Press the module’s pins firmly into the Prototyping Board header sockets.
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2.2.2  Connect Programming Cable

The programming cable connects the RCM3360/RCM3370 to the PC running Dynamic C 

to download programs and to monitor the RCM3360/RCM3370 module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J1 on 

the RCM3360/RCM3370 module as shown in Figure 3. There is a small dot on the circuit 

board next to pin 1 of header J1. Be sure to orient the marked (usually red) edge of the 

cable towards pin 1 of the connector. (Do not use the DIAG connector, which is used for a 

nonprogramming serial connection.)

Figure 3.  Connect Programming Cable and Power Supply

NOTE: Be sure to use the programming cable (part number 101-0542) supplied with this 

Development Kit—the programming cable has blue shrink wrap around the RS-232 con-

verter section located in the middle of the cable. Programming cables with clear or red 

shrink wrap from other Z-World or Rabbit Semiconductor kits were not designed to 

work with RCM3360/RCM3370 modules.

Connect the other end of the programming cable to a COM port on your PC.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use 

an RS-232/USB converter (Z-World Part No. 540-0070) with the programming cable 

supplied with the Development Kit. An RS-232/USB converter is available through the 

Z-World Web store.
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2.2.3  Connect Power

When all other connections have been made, you can connect power to the Prototyping 

Board. Connect the wall transformer to jack J1 on the Prototyping Board as shown in 

Figure 3.

Plug in the wall transformer. The core LED on the Prototyping Board should light up. The 

RCM3360/RCM3370 and the Prototyping Board are now ready to be used.

NOTE: A RESET button is provided on the Prototyping Board to allow a hardware reset 

without disconnecting power.

2.2.3.1  Alternate Power-Supply Connections

All Development Kits include a header connector that may be used to connect your power 

supply to 3-pin header J2 on the Prototyping Board. The connector may be attached either 

way as long as it is not offset to one side—the center pin of J2 is always connected to the 

positive terminal, and either edge pin is negative. The power supply should deliver 8 V to 

30 V DC at 8 W.
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2.3  Starting Dynamic C

Once the RCM3360/RCM3370 is connected as described in the preceding pages, start 

Dynamic C by double-clicking on the Dynamic C icon or by double-clicking on 

dcrabXXXX.exe in the Dynamic C root directory, where XXXX are version-specific 

characters.

Dynamic C uses the serial port on your PC that you specified during installation.

If you are using a USB port to connect your computer to the RCM3360/RCM3370 module, 

choose Options > Project Options and select “Use USB to Serial Converter” on the 

Communications tab.

2.4  Run a Sample Program

Since the RCM3360 and the RCM3370 run at 44.2 MHz and are equipped with a fast 

program-execution SRAM, you should first set the compiler to run the application in the 

fast program execution SRAM by selecting Code and BIOS in Flash, Run in RAM from 

the Dynamic C Options > Project Options > Compiler menu.

Use the File menu to open the sample program PONG.C, which is in the Dynamic C 

SAMPLES folder. Press function key F9 to compile and run the program. The STDIO 

window will open on your PC and will display a small square bouncing around in a box.

This program shows that the CPU is working. The sample program described in 

Section 6.5, “Run the PINGME.C Sample Program,” tests the TCP/IP portion of the board.

2.4.1  Troubleshooting

If a program compiles and loads, but then loses target communication before you can 

begin debugging, it is possible that your PC cannot handle the default debugging baud 

rate. Try lowering the debugging baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Project Options > 

Communications menu. Choose a lower debug baud rate.

If Dynamic C cannot find the target system (error message "No Rabbit Processor 
Detected."):

• Check that the RCM3360/RCM3370 is powered correctly — the red core LED on the 

Prototyping Board should be lit when the RCM3360/RCM3370 is mounted on the Prototyping 

Board and the AC adapter is plugged in.

• Check to make sure you are using the PROG connector, not the DIAG connector, on the 

programming cable.

• Check both ends of the programming cable to ensure that they are firmly plugged into 

the PC and the programming port on the RCM3360/RCM3370.

• Ensure that the RCM3360/RCM3370 module is firmly and correctly installed in its 

connectors on the Prototyping Board.
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• Select a different COM port within Dynamic C. From the Options menu, select 

Project Options, then select Communications. Select another COM port from the list, 

then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C 

still reports it is unable to locate the target system, repeat the above steps until you locate 

the active COM port.

2.5  Where Do I Go From Here?

If the sample program ran fine, you are now ready to go on to other sample programs and to 

develop your own applications. The source code for the sample programs is provided to allow 

you to modify them for your own use. The RCM3360/RCM3370 User’s Manual also 

provides complete hardware reference information and describes the software function calls 

for the RCM3360 and the RCM3370, the Prototyping Board, and the optional LCD/keypad 

module.

For advanced development topics, refer to the Dynamic C User’s Manual and the 

Dynamic C TCP/IP User’s Manual, also in the online documentation set.

2.5.1  Technical Support

NOTE: If you purchased your RCM3360/RCM3370 through a distributor or through a 

Z-World or Rabbit Semiconductor partner, contact the distributor or partner first for 

technical support.

If there are any problems at this point:

• Use the Dynamic C Help menu to get further assistance with Dynamic C.

• Check the Z-World/Rabbit Semiconductor Technical Bulletin Board at 

www.zworld.com/support/bb/.

• Use the Technical Support e-mail form at www.zworld.com/support/questionSubmit.shtml.
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3.  RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM3360/RCM3370

(and for all other Z-World and Rabbit Semiconductor hardware),

you must install and use Dynamic C.

3.1  Introduction

To help familiarize you with the RCM3360 and RCM3370 modules, Dynamic C includes 

several sample programs. Loading, executing and studying these programs will give you a 

solid hands-on overview of the RCM3360/RCM3370’s capabilities, as well as a quick 

start using Dynamic C as an application development tool.

NOTE: The sample programs assume that you have at least an elementary grasp of the C 

programming language. If you do not, see the introductory pages of the Dynamic C 

User’s Manual for a suggested reading list.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.

In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your RCM3360/RCM3370 module must be plugged in to the Prototyping Board as 

described in Chapter 2, “Getting Started.”

2. Dynamic C must be installed and running on your PC.

3. The programming cable must connect the programming header on the RCM3360/

RCM3370 to your PC.

4. Power must be applied to the RCM3360/RCM3370 through the Prototyping Board.

Refer to Chapter 2, “Getting Started,” if you need further information on these steps.

Since the RCM3360 and the RCM3370 run at 44.2 MHz and are equipped with a fast pro-

gram execution SRAM, remember to allow the compiler to run the application in the fast 

program execution SRAM by selecting Code and BIOS in Flash, Run in RAM from the 

Dynamic C Options > Project Options > Compiler menu.

To run a sample program, open it with the File menu, then press function key F9 to com-

pile and run the program. The RCM3360/RCM3370 must be in Program Mode (see 

Figure 8) and must be connected to a PC using the programming cable.
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3.2  Sample Programs

Of the many sample programs included with Dynamic C, several are specific to the 

RCM3360 and the RCM3370. Sample programs illustrating the general operation of the 

RCM3360/RCM3370, serial communication, and the NAND flash are provided in the 

SAMPLES\RCM3360 folder. Each sample program has comments that describe the purpose 

and function of the program. Follow the instructions at the beginning of the sample pro-

gram. Note that the RCM3360/RCM3370 must be installed on the Prototyping Board 

when using the sample programs described in this chapter.

• CONTROLLED.c—Demonstrates use of the digital inputs by having you turn the LEDs 

on the Prototyping Board on or off from the STDIO window on your PC.

Once you compile and run CONTROLLED.C, the following display will appear in the 

Dynamic C STDIO window.

Press “2” or “3” or “4”or “5”on your keyboard to select LED DS3 or DS4 or DS5 or 

DS6 on the Prototyping Board. Then follow the prompt in the Dynamic C STDIO win-

dow to turn the LED on or off.

• FLASHLED.c—Demonstrates assembly-language program by flashing the USR LED 

on the RCM3360/RCM3370 and LEDs DS3, DS4, DS5, and DS6 on the Prototyping 

Board.

• SWRELAY.c—Demonstrates the relay-switching function call using the relay installed 

on the Prototyping Board through screw-terminal header J17.

• TOGGLESWITCH.c—Uses costatements to detect switches S2 and S3 using debounc-

ing. The corresponding LEDs (DS3 and DS4) will turn on or off.

Once you have loaded and executed these four programs and have an understanding of 

how Dynamic C and the RCM3360/RCM3370 modules interact, you can move on and try 

the other sample programs, or begin building your own.
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3.2.1  Use of Serial Flash

3.2.1.1  SF1000 Serial Flash Card

The following sample program can be found in the SAMPLES\RCM3360\SF1000 folder.

• SERFLASHTEST.c—An optional SF1000 Serial Flash card is required to run this dem-

onstration. Install the Serial Flash card into socket J11 on the Prototyping Board. This 

sample program demonstrates how to read and write from/to the Serial Flash card.

3.2.2  Use of NAND Flash

The following sample programs can be found in the SAMPLES\RCM3360\NANDFlash folder. 

As you run most of these sample programs, you will be prompted in the Dynamic C STDIO win-

dow to select either the soldered-in NAND flash (RCM3360 model only) or the socketed 

xD-Picture Card (0 = soldered, 1 = socketed).

• NFLASH_DUMP.c—This program is a utility for dumping the nonerased contents of a 

NAND flash chip to the Dynamic C STDIO window, and the contents may be redi-

rected to a serial port.

When the sample program starts running, it attempts to communicate with the user-

selected NAND flash chip. If this communication is successful and the main page size 

is acceptable, the nonerased page contents (non 0xFF) from the NAND flash page are 

dumped to the Dynamic C STDIO win.for inspection.

Note that an error message will appear when the first 32 pages (0x20 pages) are 

“dumped.” You may ignore the error message.

• NFLASH_INSPECT.c—This program is a utility for inspecting the contents of a 

NAND flash chip. When the sample program starts running, it attempts to initialize the 

NAND flash chip selected by the user. Once a NAND flash chip is found, the user can 

execute various commands to print out the contents of a specified page, clear (set to 

zero) all the bytes in a specified page, erase, or write to specified pages.

CAUTION: When you run this sample program, enabling the #define NFLASH_

CANERASEBADBLOCKS macro makes it possible to write to bad blocks. The first two 

blocks on the xD-Picture Card are marked bad to protect the configuration data needed 

to use the card in a digital camera or PC. You will only be able to use the xD-Picture 

Card in Rabbit-based systems if either of the first two blocks is written to.

• NFLASH_LOG.c—This program runs a simple Web server and stores a log of hits in 

the NAND flash. As long as the xD-Picture Card is plugged in to its connector J6, this 

sample program will log hits to the xD-Picture Card. Remove the xD-Picture Card if 

you wish to log hits on the soldered-in NAND flash (RCM33600 model only) .

This log can be viewed and cleared from a browser by connecting the RJ-45 jack on the 

RCM3360 to your PC as described in Section 6.1.
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As long as you have not modified the TCPCONFIG 1 macro in the sample program, 

enter the following server address in your Web browser to bring up the Web page 

served by the sample program.

http://10.10.6.100

Otherwise use the TCP/IP settings you entered in the TCP_CONFIG.LIB library.

This sample program does not exhibit ideal behavior in its method of writing to the 

NAND flash. However, the  inefficiency attributable to the small amount of data writ-

ten in each append operation  is offset somewhat by the expected relative infrequency 

of these writes, and by the sample program's method of “walking” through the flash 

blocks when appending data as well as when a log is cleared.

• NFLASH_ERASE.c—This program is a utility to erase all the good blocks on a NAND 

flash chip. When the program starts running, it attempts to establish communication 

with the NAND flash chip selected by the user. If the communication is successful, the 

progress in erasing the blocks is displayed in the Dynamic C STDIO window as the 

blocks are erased.

Follow these instructions to set up your PC or notebook. Check with your administra-

tor if you are unable to change the settings as described here since you may need 

administrator privileges. The instructions are specifically for Windows 2000, but the 

interface is similar for other versions of Windows.

TIP: If you are using a PC that is already on a network, you will disconnect the PC 

from that network to run these sample programs. Write down the existing settings 

before changing them to facilitate restoring them when you are finished with the 

sample programs and reconnect your PC to the network.

1. Go to the control panel (Start > Settings > Control Panel), and then double-click 

the Network icon.

2. Select the network interface card used for the Ethernet interface you intend to use 

(e.g., TCP/IP Xircom Credit Card Network Adapter) and click on the “Proper-

ties” button. Depending on which version of Windows your PC is running, you may 

have to select the “Local Area Connection” first, and then click on the “Properties” 

button to bring up the Ethernet interface dialog. Then “Configure” your interface 

card for a “10Base-T Half-Duplex” or an “Auto-Negotiation” connection on the 

“Advanced” tab.

NOTE: Your network interface card will likely have a different name.

3. Now select the IP Address tab, and check Specify an IP Address, or select TCP/IP 

and click on “Properties” to assign an IP address to your computer (this will disable 

“obtain an IP address automatically”):

IP Address : 10.10.6.101

Netmask : 255.255.255.0

Default gateway : 10.10.6.1

4. Click <OK> or <Close> to exit the various dialog boxes.
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3.2.3  Serial Communication

The following sample programs can be found in the SAMPLES\RCM3360\SERIAL folder.

• FLOWCONTROL.C—This program demonstrates hardware flow control by configuring 

Serial Port F for CTS/RTS with serial data coming from TxE (Serial Port E) at 115,200 

bps. One character at a time is received and is displayed in the STDIO window.

To set up the Prototyping Board, you will need to tie 

TxE and RxE together on the RS-232 header at J14, 

and you will also tie TxF and RxF together as shown in 

the diagram.

A repeating triangular pattern should print out in the 

STDIO window. The program periodically switches RTS (TxF) flow control on or off to 

demonstrate the effect of hardware flow control.

• PARITY.C—This program demonstrates the use of parity modes by repeatedly sending 

byte values 0–127 from Serial Port E to Serial Port F. The program will switch between 

generating parity or not on Serial Port E. Serial Port F will always be checking parity, 

so parity errors should occur during every other sequence.

To set up the Prototyping Board, you will need to tie 

TxE and RxF together on the RS-232 header at J14 as 

shown in the diagram.

The Dynamic C STDIO window will display the error 

sequence.

• SIMPLE3WIRE.C—This program demonstrates basic RS-232 serial communication. 

Lower case characters are sent by TxE, and are received by RxF. The characters are 

converted to upper case and are sent out by TxF, are received by RxE, and are displayed 

in the Dynamic C STDIO window.

To set up the Prototyping Board, you will need to tie 

TxE and RxF together on the RS-232 header at J14, and 

you will also tie RxE and TxF together as shown in the 

diagram.

• SIMPLE5WIRE.C—This program demonstrates 5-wire RS-232 serial communication 

by providing flow control (RTS/CTS) on Serial Port F and data flow on Serial Port E.

To set up the Prototyping Board, you will need to tie 

TxE and RxE together on the RS-232 header at J14, 

and you will also tie TxF and RxF together as shown in 

the diagram.

Once you have compiled and run this program, you can 

test flow control by disconnecting TxF from RxF while the program is running. Char-

acters will no longer appear in the STDIO window, and will display again once TxF is 

connected back to RxF. (Do not disconnect the data path between TxE and RxE.)
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• SWITCHCHAR.C—This program transmits and then receives an ASCII string on Serial 

Ports E and F. It also displays the serial data received from both ports in the STDIO 

window.

To set up the Prototyping Board, you will need to tie 

TxE and RxF together on the RS-232 header at J14, and 

you will also tie RxE and TxF together as shown in the 

diagram.

Once you have compiled and run this program, press 

and release S2 on the Prototyping Board to send a message from Serial Port E to Serial 

Port F; press and release S3 on the Prototyping Board to send a message from Serial 

Port F to Serial Port E. The data sent between the serial ports will be displayed in the 

STDIO window.

Two sample programs, SIMPLE485MASTER.C and SIMPLE485SLAVE.C, are available 

to illustrate RS-485 master/slave communication. To run these sample programs, you will 

need a second Rabbit-based system with RS-485—the second system may be another 

RCM3360/RCM3370, or it may be any Z-World single-board computer or RabbitCore 

module that supports RS-485 serial communication as long as you use the master or slave 

sample program associated with that board.

Before running either of these sample programs on the RCM3360/RCM3370 assembly, 

make sure pins 1–2 and pins 5–6 are jumpered together on header JP5 to use the RS-485 

bias and termination resistors. The sample programs use Serial Port C as the RS-485 serial 

port, and they use PD7 to enable/disable the RS-485 transmitter.

The RS-485 connections between the slave and master devices are as follows.

• RS485+ to RS485+

• RS485– to RS485–

• GND to GND

• SIMPLE485MASTER.C—This program demonstrates a simple RS-485 transmission of 

lower case letters to a slave. The slave will send back converted upper case letters back 

to the master and display them in the STDIO window. Use SIMPLE485SLAVE.C to 

program the slave—reset the slave before you run SIMPLE485MASTER.C on the 

master.

• SIMPLE485SLAVE.C—This program demonstrates a simple RS-485 transmission of 

lower case letters to a master. The slave will send back converted upper case letters 

back to the master and display them in the STDIO window. Compile and run this pro-

gram on the slave before you use SIMPLE485MASTER.C to program the master.

*+,
�+	����+	�����
����+%����+%����
�����
����
'



User’s Manual 19

3.2.4  RabbitNet

Sample programs are available for each RabbitNet peripheral card, and can be found in the 

Dynamic C SAMPLES\RabbitNet folder. When you run any of these sample programs 

in conjunction with the RCM3360/RCM3370 and the Prototyping Board, you need to add 

the line

#use rcm33xx.lib

at the beginning of the sample program.

TIP: You need to add #use rcm33xx.lib at the beginning of any sample program 

that is not in the Dynamic C SAMPLES\RCM3360 folder.

3.2.5  Other Sample Programs

Section 6.6 describes the TCP/IP sample programs, and Appendix C.7 provides sample 

programs for the optional LCD/keypad module that can be installed on the Prototyping 

Board.
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